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Welcome to the VA North Texas Healthcare System! 

This guidebook will help orient you to the VA and provide helpful tips for using the EMR (CPRS). 
 
Important Locations: (See end of document for Campus Map) 
 
1) Building 2:  

a. Medical Service Administration suite, conference room, administrative staff, Dr. 
Miller, Dr. Chong, and Chief Residents are located on the 8th floor 

b. Med-Surg acute care patient wards are located on floors 4-7 
 

2) Ward team rounding rooms: Take the central elevator in Building 2 to the 8th floor. Walk 
down hall AWAY from medical service admin suite (where we have noon conference at 
VA), take left. There will be a small hallway on your right (With a large door w/ impressive 
Keycode), next to room 8C 201A. Team rooms are located in the back. 
 

a. Hallway Door Code: STAR-->3420-->Bottom R button  
 

o UTSW ward teams A-D: room code is 3420 
 Team A – Room 8C – 210 
 Team B – Room 8C – 211 
 Team C – Room 8C – 212 
 Team D – Room 8C – 213 

 
o Baylor Ward Team E: room code 5320 

 
3) Clinical Addition: The building where Prime Clinic (Clinic 3, 1st floor), several of the 

subspecialty clinics, the ICU/CCU/SICU/TICU, and some ward floors (5A tele and step 
down) are located.    

 
4) CP-ICU rounding room: Take the blue elevator in the clinical addition building to the 5th 

floor. Rounding room is right on the back of the elevator, room 5B-600. Door Code: 1430. 
 

5) ED: Clinical addition building first floor (right by the piano in the lobby). ED Door Code 
changes frequently; Currently 0711#.  If the code doesn’t work, you can ask the staff at the 
desk just to the right of the door and they will usually let you know the new code. Phone 
number for ER: 71975. If you want an order done down there, kindly ask the ER MD signing 
out to you to order the test/image/medication as your orders are only effective once patients 
arrive to the floor.  

a. To see what meds they have given, look under notes, then ER nursing 
medication administration note.  

 
6) Medical Service Conference rooms: 

a. “Small” conference room: on the left, just outside of 8th floor Medical Service 
Admin office suite (Rm. 8C-302) 

b. “Large” conference room: inside the 8th floor Medical Service Admin office suite, 
at the very end of the hallway (Rm. 8C-409) 

7) Call Rooms 
a. Wards: 8C-229a and 8C-229c 

i. Intern/ Resident Call Rooms: 8th Floor, down main hall from where 
rounding rooms are located.  (Turn right after exiting the small teamroom 
hallway where medicine rounding rooms are located. You are now in the 
larger hallway. There will be another small hallway located about 25 feet 
down the hall on the left.). 

ii. Call Room Code: 3420 
iii. Talk to Lynne Anderson for any maintenance concerns 

1. Mon-Fri: Mr. Ellis 817-937-8696 and Mr. Strain 214-929-7977 



2. Weekends: Mr. Chism, 214-604-9068 
3. If the above fails to resolve the issue or if no one answers the 

other lines, please call Eugene Uche 214-274-4680 
b. CPICU: 5A-118 and 5A-120  

i. Clinical Addition, blue elevator to 5th floor, in the hallway across from 
MICU/CCU. Code 145.  

ii. These are reserved for the CP-ICU resident and intern only. 
8) Lactation space: 

The two ward team call rooms can be used as space for residents who need to pump.  
These are dedicated rooms used only by residents at night and may be locked from the 
inside so should allow for privacy.  If you have any specific needs or concerns related to 
nursing/lactation, please contact Dr. Chong and she will help you make arrangements 
while  you’re on rotation here. 

 
Conferences and other meetings: 

 
1) Inpatient Multidisciplinary (Discharge) Rounds: 

a. Mon- Fri between 8:00am and 8:30am via phone conference 
b. There are two dedicated Case Managers (Peggy “Denise” and Tomika) and Social 

Workers who round briefly with each of the ward teams to discuss discharge 
planning and needs.   

i. Used to be in-person, currently remains “virtual” via phone call to  your 
rounding room during this time frame.  

ii. Please be prepared to discuss discharge needs (patient name, last 4, 
location, 1-liner about admission, anticipate discharge needs to get them out) 

iii. The social work call roster can be found in the W drive—the file is updated 
each day with the social worker assignd to the bed  

2) Educational Conferences: 
a. Prior to COVID19, all conferences were provided in-person by UT Southwestern in 

the medical service conference rooms. Currently, the majority of conferences remain 
in virtual format, although this may evolve during this academic  year.  

b. Please check for updates from your Chief Residents on conference formats and 
locations this year.   

c. All ward team rooms are equipped with webcams, speakers, etc. to allow you to 
access virtual conference content via zoom or any other platform.  

3) Food:  
a. IM resident lunches will still be provided for pickup in the medical service large 

conference room. 
b. There is a coffee shop and a “canteen” (small store) on the 1st floor and a Cafeteria 

in the basement of building 2.  
c. If you take call, check with your Chief Resident for meal vouchers. 

 
Assigning yourself to your patients/Paging: 
 
Calling Pages Back: You can dial the 5-digit number back into a VA phone as you see it. Or, 
you can use your cell phone and type in 214-857-xxxx (using the last 4 digits of the page). 
 
Wards: There are 4 team pagers for each UTSW wards team (A/B/C/D). Team pager is shared 
by intern and resident. Intern should carry it, but resident should call back admissions along with 
the intern. Your team pager will be listed under the resident’s name in CPRS as the contact 
number for your patient. You should be receiving all pages on your team pager; however, carry 
your personal pager as backup. 



Night intern should carry all 4 team pagers and your personal pager. You have to carry all 
pagers as you will get pages on all of them.  
 
The Baylor team will have a Team E pager, which will be used to contact the team. The number 
is 214-786-0975.   
 
If you have any issues with this pager, please contact one of our ADPACs (Carlton Ingram or 
Elaine Briggs in the Medical Service Admin Suite).    
 
 
 
My CPRS access doesn’t work? 
First step is to call Lynne.  She can likely help you faster and more effectively than the VA 
enterprise help desk. Remember that you do have to log in every few months to keep it active.  
 
I have VA/CPRS access, now what?  
Put in your non-PIV card, type in your 6-digit pin. 
When you are logged in (may take several minutes), on your desktop, click on the star icon 
(NTX GUI executables) and then on CPRSChart NTX, then log in with your CPRS username 
and password.  
The old way to log-in is to use your windows username (vhantx*****) and password  
 
Tip: You can open multiple CPRS at a time. However only one will be “linked” and is the 
only one you’ll be able to open images from.  A good way of doing things is to start your 
note in an un-linked CPRS, and then use the linked CPRS to look up other notes, labs, 
images, etc. You can press Alt+tab to quickly switch between the CPRS windows. 
 
Set up a printer (Must be done on each  different computer that you login to) 
1. Click on the star icon on your desktop- > NTX shortcuts -> NTX printserver 
2. Find the name of your printer (label on the front of the printer) and double click on it 

 
Fax machine: 
Is located in Room 8C-213.  The fax number is 214-462-4792. 
 
Create your patient list 
- Open up any patient’s chart -> Go to tools (top of your screen) -> options -> Lists/Teams> 

Personal List -> New list -> type in name of your new list (if you make multiple lists, it is a 
good idea to start your list with your initials since when you select your list, you select it from 
a list of many people’s lists) 

- To add a new patient: Type the first letter of their last name followed by the last 4 of their 
SSN- > add to list 

- To default your list: File (top of your screen)-> Select new patient to get to the Patient 
selection screen -> select team/personal-> type in name of your list -> click Save patient list 
settings on right hand corner  

- You can set your list public or private by clicking the *** box 
- All updates from your patient list will automatically be pulled into your “inbox” 
 
Notes 
 
Set up your notes view - Why should I do this? 
 
This will group the notes by title, which makes chart checking so much easier, but stills allow 
you to view all notes by date rather than note title. 
 
How do I do this? 



Go to “notes” -> view -> custom view. Select group by title, max return of 1000 (can make it 
higher if the patient is a VA frequent flier, but note that this will make CPRS run slower). Then 
click “view” and save as default view.  
 
If you want to just view all notes by date, you just click All signed notes on the left, and the top 
right panel will display all notes in descending date order. 
BE AWARE: D/c summaries are under a different tab, as are operative notes. 
 
Is there a search function?  
Search Function in CPRS: 
CPRS: 

I. Notes -> “View” tab -> “Search for Text” 
 
Writing Notes/Templates: 
 

 Wards: 
o To create an inpatient note, go to the “notes” tab on the bottom, click on “New Note” 

(bottom left corner), then choose a template (Med History & Physical- Team X or 
Med Daily Note- Team X for daily progress notes).  

 
 

o Other useful inpatient templates: 
 Cross cover note: “Med Interim note” or “Med Cross Cover Note” *** 
 Procedures: “Procedure note” -> template will pop up 
 Send patient to SNF: “inter-facility transfer note” 

o To pend a note: right click and select “save note without signature” 

o To edit an unsigned note: right click and select, “edit note” 
o To sign a note “right click and select “sign note” 

 

 ICUs: See CP-ICU orientation materials for templates specific to that rotation 

 For subspecialty clinics, your attendings should direct you to the correct templates for the 
clinics and consults. 

 For Prime clinic: see Prime specific orientation materials provided by your Chief Residents 
and Dr. Brancaccio (Clinic director) 

 NOTE: You CANNOT modify signed notes in CPRS (you have to add an addendum that 
shows up as a separate note), so avoid accidentally signing your note when leaving a 
patient’s chart. You can accomplish this by unchecking the note box when it asks you to 
sign all orders upon exit (NOTE: this is very easy to overlook, so make sure you don’t 
accidentally sign your note if it is not complete). 

 
 
 
 
Finding Useful Information 
 

I. Finding your patient 
How to find patients in CPRS by location: 

I. Patient selection screen-> Click Wards -> Scroll to 5ACCU or 5AMICU 
II. Applies to patients in other wards too (helpful in looking up patients at codes) 



II. Vitals 
I. Wards: On the cover page. If you click on one of the VS, a box with the trends will 

pop up. 
II. ICU: Open “Essentris” from the desktop. Use same login as you do for CPRS 

III. Ins and Outs:  
I. Wards: Tools -> clinical flowsheet. You have to sign in with your CPRS username & 

pw. Select Ins & Outs, then pick the start and end times 
II. ICU: Go to “Essentris” from the desktop --> I/O flowsheet 

 
IV. Medications: 
Cover page, medication tab at the bottom of the screen, or orders tab 

I. If you double click on the order you can see if the medication was given or held 
II. If you want to see the MAR that is under “Reports” tab, and then “Med Admin History” 

III. To see specific active antibiotics, right click on the antibiotics order and choose Details. 
IV. To see all medications prescribed at the VA ever: Reports tab -> Clinical Reports - > 

Pharmacy -> All medications 
V. To see the antibiotics the patient received this admission What antibiotics has this 

patient gotten this admission, click Labs tab -> Graph(pop-up) -> Views tab (top left) -> 
ID-antibiotics -> Date range (bottom left corner)  
 

V. Labs 
Essentris: 

I. Select patient -> left column “Labs” (Erlenmeyer flask picture) -> click through tabs at top 
II. Note that for micro and path, need to look in CPRS 

 
CPRS: 

I. Labs tab -> Worksheet (can make own test groups, or type in “CMP,” “CBC,” etc.) 
 

 
VI: Et cetera 
Immunization summary: Reports tab -> health summary -> immunization summary 
Anticoagulation: Reports tab -> clinical report- anticoagulation flowsheet 
EGD/Colonoscopies: Reports tab -> health summary -> ???? 
 
Review consults: Consult results may show up in a note, but you also may find them under the 
“Consults” tab. If you click in the upper left hand corner on the consult that you previously 
ordered. Just scroll down in this consult order and often you'll find the consultant’s reply. 
 
Imaging (radiology, ECGs, PFT reports, etc.) 

I. See the image: Tools (Top Horizontal Bar) -> vista imaging 
II. Read the report: Reports tab (Bottom Horizontal Tabs) -> imaging 

 
Cardiac reports: Click on the “Notes” tab on the bottom of your screen and look for the 
“Cardiology echo reports” (older echo’s may be found in Tools, Cardio reports). Additionally, you 
may have a lot of success by (after your notes are set up with the above filter) looking for 
“Cardiac Echo Report” notes. 
 
Micro: Same place as “Labs” but there is a separate “micro” section in the left hand column. 
Beware that this is mainly cultures, and will not have PCRs and other serological micro-related 
tests. Be sure to check your micro results daily as there is no “Results flag” to tell you 
when new information returns.  
 
Antibioigram in CPRS:Tools -> Resources -> Antimicrobial Stewardship 
 



Invasive Devices: Select patient -> left column “Flowsheets” (up and down arrow) -> click 
through tabs at top. Note that the “invasive devices” tab has patient lines and the dates they 
were placed 
 
Pathology: Reports tab-> anatomic pathology 
 
Summary Screen in Essentris: 

I. Select patient -> left column “Summary Screens” (Sigma symbol) -> tab at top “Critical 
Care Rounding” 

 
Outside VA records: JLV (Joint Legacy Viewer) button on top right hand corner of CPRS cover 
sheet (see below) 

 

 
 
 
Admitting a Patient 
 
Admission Orders: 

 Click Orders tab 
 Click "Write delayed orders” (top left corner) (this is important otherwise the orders will D/C 

when pt is moved to the floor.) 
 Select your orders: you can admit someone under medical observation, medical 

admission, telemetry admission, step down or ICU. If you do medical observation and want 
telemetry, do medical obs and at the end it will give you an option to click telemetry (this is 
useful for chest pain rule out.) 

 Enter your orders: Write all orders under "delayed orders” (not active orders).  
 Location:   

- Wards: All of our patients except for step down go to 7c. If 7c isn't an option, just click 
7amed. 7c200 has tele, 7c100 does not have tele. Those patients go to the 5th floor.  

- CPICU: Select MICU or CCU if you know, but doesn’t matter too much 
 Medications: Under Meds tab, highlight any outpatient medications and then right click and 

select “transfer to inpatient”.  
- A lot of orders and “order sets” are under "service specific orders-> Medicine Orders" 
- To choose from admission order sets, select the Admit to … Order menu 
- Hold down CTRL while you click all the admission orders you want, and the computer 

will “guide” you through the admission process – for example, hold down CTRL while 
you click Admit Single order, Vitals, Activity Orders, Patient Care Orders, CALL MD, 
Diet, DVT Prophylaxis 

- You can also click under "Patient care orders" for a lot of the admission type orders  
- If you need a complex diet (like multiple things such as fluid restrict, low fat, consistent 

carb, etc.), click on diet, then other diet orders on far right. It will allow you to click 
multiple specifications. 

 
Must have orders on admission (to avoid pages) 

o Vital signs 
o Notify MD (remember to review the thresholds for when you want RN to notify 

you) 
o Patient care orders (I/O, weight)  
o Diet 



▪ Expiration of an NPO order may have the undesirable consequence of 
automatically reinstating the patient’s previous diet order 

▪ Rather than manually discontinuing or cancelling an NPO order, a new 
diet order should be entered when clinically appropriate, which will allow 
the NPO order to be replaced with an appropriate order. 

 
ED “Virtual” Ward Admissions: 
The VA is nearly always at full capacity, with rare exceptions.  To help facilitate movement of 
patients waiting to be admitted from the ED when there are no acute care beds available, we 
have started a “virtual” ward in the CDU (Clinical Decision Unit) in the ED.  These patients will 
be either Obs or regular admissions that will be called to you by bed control just like any other 
ward admission, but they will be physically located in the CDU in the ED and “virtually” located 
in CPRS in a ward level bed.  You place admit orders just like any other admission once the 
patient is in that “ED V Obs” or “ED V Wards” CPRS location in the header.  The main 
differences are: 

 Nursing will be ED nurses physically in the CDU.  You should communicate with 
them on time-sensitive or important orders/changes to care plan. 

o Extensions: 73911 or 70320 to reach the charge nurses in CDU 
 Orders that are placed under this status should follow the patient once he/she 

physically moves to the floor (since they remain ward level inpatient status), with 
the exception of LAB orders that have not been completed or are recurring/standing 
lab orders.  Those must be reordered once the patient arrives to the real ward bed.   

 
Placing Orders 
Go to “Orders” tab. All types of orders should be available in your left-hand column 
 Meds: most of them will be under “Inpatient medications” -> other inpatient meds -> and type 

whatever you want. 
 Fluids: IV Solutions 
 IV electrolytes: Service specific orders -> Medicine service -> IVs -> IV medications 
 Order blood: Orders -> blood products -> select your blood product and then follow the order 

set 
 

NOTE: All orders have an expiration date for some reason. This becomes an issue with 
long-term stay patients, for example: DVT ppx expires after 7 days, daily weights expire after 7 
days. Antibiotics typically expire after 7 days. You have to check the meds for expiration dates 
at least once every few days, and if someone stays for longer than a week, make it a point to 
review all their orders to make sure there are no issues. 
 
Labs 
 
Ordering:  
Go to Order -> lab orders (tab on the left) -> scroll down and click on “other order” then hand 
type them. There are pre-selected options but sometimes they don't work. It’s better to do it this 
way. If your patient is on the wards, they’ll be “lab collect”, unless they have a PICC or are in the 
unit, then they will be “unit collect”. If you want a STAT lab it will be “immediate collect”. After 
you select all the labs you want, go to the first tab on the top left and select “sign/release orders” 
and sign them.  
 
 

Note 1: You have to order your morning labs EVERY DAY and for every occurrence (no 
BID labs you have to order am and pm labs every day). So put this on your to-do list 
and remember to do this EVERY DAY (you can order daily labs by selecting AM Lab 
tests and holding down CTRL while clicking all the AM labs you want – if you are in the 
MICU/CPICU, don’t forget to change the collection to ward collect.) While many 
orders give you the option to order for many days in a row, or multiple times a day, these 
labs will often NOT BE COLLECTED unless you reorder them every day. Don’t be fooled! 



 
Note 2: If you cannot search for the order, it may need to be ordered as a Miscellaneous 
lab. Call lab to clarify. You will need a Tissue Examination form for cytology (If you 
cannot find any in the rounding room, you can pick up the form at the lab). Specimen 
needs to be turned in with the form to be processed.  
 
Note 3: You can do an add-on by ordering it as ward collect, and then calling the lab at 
70666 to request an add-on. They will ask you for the old order number and new order 
number, which you can see on the orders tab. Fun fact, there are many labs you can add 
on to a patient’s BMP, so always call first if you have one before reordering.  
 

Labs Status: 
 
Go to “Labs” tab and select “Labs status”. Here you will find whether labs are scheduled to be 
collected, cancelled (patient refused, or “something” happened), collected, in process, etc. It is 
better to go to this tab instead of “Orders” because sometimes the order disappears and you 
don't know why (cancelled, collected already, never ordered). 
 
Reviewing Labs:  
 
Go to the “Labs” tab on the bottom of your CPRS screen. Click “worksheet” on your left hand 
column. You can steal others worksheets (CBC, LFTs, BMP) or create your own. This way you 
can trend the labs rather than clicking through the most recent only. 
 
To Create Your Own Worksheet: “Labs” tab - > “worksheet” on the left column -> under the labs 
drop down, select labs (you can add any number to for your group) and these will show up in 
the box to the right. Once you have you group, click “new” at the upper right of the box, and this 
will create a pre-set group of labs. 
 
If you would like to receive an alert (or assign the alert to another provider like your 
intern/resident, etc.) on any lab or imaging that you order, CPRS allows for this. After placing 
the order, highlight the order under the ORDERS tab, then on the toolbar go to Action  Alert 
when results  then select the person the alert should be sent to  (see graphic). 

 

Want your labs to look professional? 
 Go to labs -> all labs by date -> today -> select all and copy 
 Go to valabformatter.com paste all that stuff and click submit. This will automatically 

calculate MELD, FENa, FEUrea, correct Na for glucose, etc. 
 Voila! pretty labs for your note! (I personally did this on all my HP’s, daily notes I just put 

“labs reviewed notable for ***) 
 

 
 



 
Consults / Pages 

a. Place a consult: go to “Consult” at the bottom of your screen-> “new consult” -> 
you will mainly use “inpatient medicine” Most inpatient consults require that you 
also page and talk to someone on that team! (read below) 

b. To find out who’s on call for other services, there will be a list of word documents 
found: Start Button (lower left hand corner of computer screen) -> Computer -> 
NTX WorkGroup Drive -> Call Rosters 

c. Alternate Way: Call a consult: Go to http://vaww.northtexas.va.gov  in Internet 
Explorer -> on call schedule -> select your service -> click on the month and the 
schedule will pop up with the pager number of the person on call 

d. To send a text page once you have the pager number: Go to spok.com. 
 
Orders that Are Not Orders 

This is when it gets trickier. Below are orders that are not obvious, since they are not listed 
under orders but instead under consults or are accessed from some other random place.  This 
is the greatest pain of the VA CPRS system. 

 
Orders that require extra clicking 
1) PICC/midline: Patient care orders or service specific orders -> Medicine -> IV orders 
2) Duonebs, O2, ABG is all under respiratory care orders. 
3) IV Fluids are all under IV solutions.  
4) Drips: you can either enter it under IV solutions and additives or look for it under Service 

specific orders -> SICU/TICU. 
5) If you have Vanc on any patient, your pharmacist will manage the troughs and dosing. You 

just have to cosign the orders. NOTE: Team pharmacists are not at the VA on 
weekends/holidays, so clarify when you need to be the one ordering, monitoring troughs and 
adjusting dosing. 

Note: there is a helpful antibiotics and vancomycin dosing guidelines on 
http://vaww.northtexas.va.gov.  

6) If you order Zosyn, order the extended infusion option. 
7) 1:1 sitters or 2:1 obs: Service specific orders -> mental health -> acute psych patient care 

orders -> close observation choices. If you can’t find this, you can also click on Patient care 
order -> Text order to unit and type in the request.  

8) Insulin orders are under service specific orders, medicine orders, scroll down to medications 
and then click insulin management protocol 

9) SCDs: Patient care order 
10) Restraints: Service specific orders ->medicine ->restraints OR service specific orders -

>mental health -> acute psych text order. This will need to be renewed daily (expires every 
midnight) 

11) For insulin, go to “Orders” > “service specific orders, medicine” in your left hand column > 
“medications” > “insulin management” > “basal + meal”; NOTE: If you want an ISS only, just 
don’t order basal, and do order the meal but then cancel the actual pre-meal dose and just 
continue through with the rest of the order set which will be ISS + hypoglycemia protocol 

12) D- stick for poc glucose orders under insulin order set 
13) Insulin drip: Service specific orders -> SICU/TICU  
14) Telemetry: Service specific -> medicine -> telemetry 
15) ECG: Service Specific Menu -> EKG in Right column 
 
Orders Listed under Notes 
 



1) Heparin drip: Go to notes and select "Heparin protocol note" under notes tab. It will bring up 
all the orders for it. 

2) Restricted drug requests: (NOACs, Plavix, ARBs) Start a note called “RDR Restricted drug 
request” and follow the instructions 

3) Discharge Order: “Inpatient Discharge Instructions”. 
 
Order Listed under Consults 
 
1) PT/OT : Consults -> PM&R services 
2) Home health : GEC Outpatient -> skilled nursing (Many times you will have to network with 

your social worker to understand exactly what type of GEC therapy is needed, they are right 
down hall from inpt team rooms, just ask them). The GEC orders need to be signed by the 
attending. Otherwise, it will be cancelled. Also, if it is during the week – feel free to ask the 
SW/CM to walk you through this ordering process the first few times. There can be many 
questions that arise, they will often know the answer for these order sets to ensure they 
actually are approved. 

3) Echos: Consult -> medicine inpatient -> cardiology services 
4) PFTs: Consults ->Medicine service -> pulmonary service 
5) Doppler carotid: consults -> surgery -> vascular surgery 
6) Vein mapping: consult -> surgery -> vascular surgery 
7) Wound care: Consults -> nursing services -> Inpatient Wound Care 
8) EEG: Consult -> Medicine Svc inpt -> Neurology Services 
9) Speech therapy: Inpatient medicine -> audiology 
10) Non-formulary Medications: Consults -> Pharmacy services 
11) Sleep Study: Consult tab -> medicine outpatient -> Neurology -> sleep study 
12) Colonoscopy: Consult tab (do not click new consult button) - > “New Procedure”  
13) Any Devices/Prosthetics: Consults tab -> Prosthetics 
14) Travel Request (for discharge): Note tab -> New note -> type in Beneficiary travel. This is 

extremely complicated to do, ask your social worker for the multi-page document that shows 
you how to appropriately fill it out). Noted that the discharge order should be signed to have 
the consult for travel request looked at. To facilitate the request, ask the clerk on your 
patient’s floor to call for transport once the consult is in. 

15) Referral to Anticoagulation Clinic – Consult tab -> Pharmacy  
16) Prosthetics Request (includes Wheelchair, Artificial Limbs, Braces, Shoes, Compression 

Socks, Wound Care, Glasses, Respiratory Supplies): Consults -> Prosthetics Request  
17) Non-Formulary Medications: Consults -> Pharmacy Services -> Non-Formulary Drug 

Request 
a. Does not apply to certain medications (e.g. Chantix (Varenicline)): Notes -> 

Restricted Drug Request or RDR  
 
Transfer a Patient from one level of care to another (or make them full admit from 
observation) 
 
1) Go to: Medicine specific orders -> medicine service -> admit/transfer single order (tele, wards, 

ICU, etc.) 
2) Then you have to redo all the orders under delayed orders.  
3) To continue active orders: Copy all the orders you want -> right click -> copy to new order.  
4) For new orders: Orders-> write delayed orders -> type of admission -> highlight all the 

orders you’d like to transfer. 
5) If asked to place a transfer orders to move patient to COVID ward, simply place transfer 

order. Delayed orders are not required. 
 



Change Treatment Team 
Change inpatient Provider Order under Write Orders on left side of Orders tab -> send message 
to unit clerk (right side)-> type “change attending/team/resident to XXX”. 
 
Discharging a Patient 
Follow this order 
1.   Medication reconciliation: You do this manually. 

Delete old medications from outpatient medication list. 
For new medications: 
 Select the medication listed under inpatient: Action-> “transfer to outpatient” OR  
 Place an outpatient order (orders -> outpatient orders  -> medications).  

 New IP Medications: select “pick up at the window”. If you order them after 4:30, call the 
outpatient pharmacy (number on board) to remind them to fill it soon so that the patient can 
pick up on way out. 

2. The medication reconiclliation note is not necessary any longer  
3. “Inpatient discharge instructions” note -> fill it out -> sign. After you sign it a discharge 

order will pop up. Sign this and order whatever immunizations you want and write your 
discharge instructions.  

4. Go to orders tab -> you will have discharge orders to sign. Select them and sign them.  
5. For the “Return to clinic order” write the name located in the information box in the top 

(usually starting with DAL MH … ). If you cannot find it (you usually won’t) just type ****, 
specify what clinic in the instructions, and the unit clerk will make the appointment. In the 
next box under clinic name, you can write what labs you want. NOTE: If the patient has not 
been seen in the outpatient clinic previously and you want a new referral, it is an 
outpatient consult (not ‘return to clinic’).  

6. Discharge summary:  

 Must be completed within 24 hours of discharge, but ideally the same day.  
 Go to the discharge summaries tab at the bottom of the screen. Create a new discharge 

summary. Identify your co-signer attending.  
 Follow the template and complete your note, then sign.  

 Add PCP as a co-signer once you have signed your note by right clicking on the 
completed signed note and clicking identify additional co-signers. 

Tips 
 If they need a prosthetic (cane, walker), it is under consults, prosthetics. The patient can 

pick up on way out or they will mail it. 

 If they need a ride: it is a travel request and you’ll need to open a new note Beneficiary 
Travel (ask the SW for the document on how to do this step by step)  
 

Sign Out:  This info is carried across providers, so if another resident updates it, you can see these 
changes. 
- Go to tools -> Shift Handoff tool.  
- Use your own list, click submit, fill it out, and print it.  
- Sometimes this can be bugged, especially if multiple people are editing the lists. This 

sometimes requires you to delete the patient on the list and re add them. 
 
 
 
 
 
 
 
 
 



 
PRIME CLINIC: 
Clinic Work Flow and Steps:  
1) Patient list will typically be laying on computer in your assigned room 
2) Check if vitals or labs drawn for the day. If not, it is possible they are not going to show up or 

they are late (sometimes the lab can take a while), but call them and check (To find number, 
click on their name box) 

3) Start looking them up, once the patient has a nursing note in that says “Preventative Health 
Screening Note” they are ready for you to go out and call them. 
4) During Visit, complete: medication reconciliation and ensure their current medications 

have refills. Order any Refill, Renew, and enter new medications.  
a. REFILL: (patient has refills remaining) Click on the Meds tab, check the expiration 

date.  If the prescription will expire before the next scheduled visit, right click and 
choose Refill (note: refills may only be mailed).   

b. RENEW: (patient does not have refills remaining).  Right click and click on Renew.  If 
the current order is correct, click the Accept Order button.  If the medication is not 
renewable, a New Order must be entered to continue the medication.   

c. NEW ORDERS:  Select OUTPATIENT ORDERS under the Write Orders List and 
select your service (Medicine) (use all CAPS for medication orders).    

d. Sign Orders: go to the File drop-down menu and select Review/Sign Changes, 
enter your electronic signature, click OK. 

5) While writing a note, click on the left-hand tab that says “reminders.” This will open up a 
window with several clinical reminders (ex. Colonoscopy screening) à may be due at this 
visit (sometimes there are inaccuracies and sometimes patients get screening done outside 
of the VA). If you believe a reminder is due, click on reminder,answers will autopopulate into 
your note. Don’t forget to put in the appropriate orders (ex. actually ordering the 
colonscopy). Tip: complete the reminders one at a time, click finish after each instead of 
clicking next. If you do not fill out a reminder completely, you will have to quit the reminders 
set and abandon the previous work. 

6) Once you see the patient, go staff them with your attending.  
7) THIS MUST BE DONE BEFORE YOUR PATIENT LEAVES:  

a. ”Prime Clinic After Visit Summary” and select “Medication Reconciliation.” Here 
you will click through the menu and will auto-generate patient discharge instructions. 
Once you click finish, you can edit your note with additional text (or write it with pen) 
that you would like your patient to now about their clinic visit. Tip: if you sign all of 
your orders before you start your After Visit Summary Note, it will automatically pull 
in your orders into the note, including changes to their medication list. Hand the After 
Visit Summary to the patient before they leave. 

8) The After Visit Summary Note will automatically link to a “Return To Clinic” order. Fill in 
when you want your patient to come back (make in multiples of 5 weeks from today, unless 
they need to come back sooner for a PA visit). Tip: type “t+5w” to designate 5 weeks 
from today. 

9) In the “Return to Clinic” order, the right side has boxes to select for commonly ordered 
labs. If your patient is to have labs done upon their next clinic visit, please select “labs, non-
fasting, and select the boxes you deem fit (commonly ordered labs menu: CBC, BMP, CMP, 
lipid panel, hemoglobin A1c.) There is also an area to type additional notes and orders for 
the clerks. Here you can type other labs you would like them to order (e.g. HIV, HBV surface 
Ab, RPR, ESR, CRP).  

Once you send the patient out, you must do a few things:  
a. A manual med reconciliation note must be completed (make sure their current 
meds have refills).   
b. THEN: Click the “Encounter Tab” on the Note tab, a new box will open up, under 
“visit type” click “Expanded Problem Focus” Under the section name box, for available 
providers, select your attending and put them as the Primary provider.  



c. THEN, click the diagnoses tab at the top of the same pop-up box. Select the 
diagnoses that applied to your patient. Make sure you SIGN the return to clinic order 
because if not, the schedulers will have to come into clinic and remind you to sign it so 
that they can schedule the follow up.  

 
Common Tips and Orders:  
10) Consults: Before placing a consult, it is REQUIRED that you enable to Decision Tool for 

consults by clicking on “Tools” -> “Consult Toolbox” -> “Enable Consult Toolbox. This has to 
be done once on EVERY computer you use in clinic. Once you place your consult, a screen 
will pop up that says “Launch DST” which you must click on. This will take you to another 
website where you must click thorugh the questions and then make sure you link your 
answers to your consult. IF YOU DON’T FOLLOW THESE STEPS, YOUR CONSULT WILL 
GET BLOCKED NO MATTER WHAT. Again, it must be enabled on every computer you 
use. Once you enable it on each computer, you won’t have to do so ever again on that 
machine. 

11) Add Non-VA Medications to their Medication List: Orders -> Meds Non VA -> Enter Non VA 
Medications  

12) Advance Directive Reminders: Notes -> Advance Directive Notification and Discussion -> 
Complete Pop-Up for upload of their completed advance directive to Vista Imaging/CPRS or 
will consult chaplain/SW to start advance directive discussion 

13) Consults without Orders: Audiology and Optometry have a walk-in set-up. You can direct 
your patient to their clinics directly or have the clerks direct them following your clinic visit 

14) Clinic/Notable Locations: 
a. PRIME: 3 (first floor) 
b. Rheumatology: 3 (first floor) 
c. Renal: 5 (third floor) 
d. Dermatology: 5 (third floor) 
e. Diabetes: 8th floor (well women’s center) 
f. Radiology: Third floor 

15) Common Forms (Now found online) 
a. Go to http://vaww.northtexas.va.gov 
b. Click on services in the left column located towards the bottom of your screen 
c. Click on your email address: firstname.lastname@va.gov. If your email does not 

work, contact Carlton Ingram or Elaine Briggs (ADPACS). 
d. Locate and click on the Medical Service website 
e. The Medical Service website will come up (PRIME clinic educational links on the 

right) 
 

 
 
—————————————————————————————————————— 
VA lab formatter, note templates courtesy of Udayan Shah, Class of 2017 
 
 
Where To Go for Rotations: 

 
Check imweb.swmed.edu 

 
VA PARKING: 
Please refer to the following maps for parking and building entry. 

 

Directions:  

Coming from 35: Go down Ann Arbor and take a right at the Ann Arbor entrance marked with a 
red star, then proceed to one of the parking garages or lot (green rectangles). 



Coming from 45  Loop 12/Ledbetter: take a right onto Veterans Drive and keep following 
until you just pass a school on your left, then take a left onto Veterans Drive to enter VA campus 
(green star), then proceed to one of the parking garages or lot (green rectangles). 

After hours/weekends/holidays: only the Main Entrance is open (blue star) and the Ann Arbor 
and Veterans Drive entrances are closed.  You can pretty much park anywhere that is open.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Building entry:  

We recommend you enter through the SCI (Spinal Cord Unit) building entrance and follow the 
path into the VA. (See next map.) On weekends and after 10 pm, the SCI entrance is not open. 

**Due to COVID19, there are limited entrances open (SCI entrance, ER entrance) where 
screening (temp check or thermal scan, wristband and disposable mask) occurs so you must 
enter through one of these entrances.  On weekends/after hours/holidays, the only building 
entrance open is the ER (at the main entrance). 
 
From the SCI entrance, follow the orange line to get into Building 2 (green box is elevator bank) 
or keep going to get into Clinical Addition (red box is elevator bank). 
 



 


